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Introduction

The Vicomsoft Internet Gateway software is an easy to use, cost-effective way for all LAN
users on your network to simultaneously share one Internet account. The Internet Gateway
allows users to share one means of connecting to the Internet.

This QuickStart Guide includes information on installing, registering and details on manual
and automatic configuration. Full details and descriptions can be found in the User Guide.
This guide is designed to help you get the maximum benefit from the Internet Gateway
with the least investment of time.

Make sure you have all the required information for configuration listed later in this
section, i.e., your Internet Service Provider (ISP) phone number, user name, password, any IP
addresses you might need, and information about your LAN and client systems.

The next page shows a map of the process you will take to configure the Internet Gateway.
Following this guide should take you to a fully installed and working Internet Gateway
and Network.

If have trouble setting up your Internet Gateway, and have read this guide, the User Guide,
and the Read Me installed with the software. Call Vicomsoft technical support at one of

the following numbers:

North America: +1 650 691 9520
Europe / Pacific: +44 1202 293 233

Or send email with your configuration file to:

North America: support_l@vicomsoft.com
Europe/Pacific: support@vicomsoft.com
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Installation and QuickStart Introduction

Required Information for Configuration

Before configuring, please make sure you have the following information about your
Internet account and your network requirements:

] po you have a static IP address or a dynamic IP address assigned to you by your Internet
Service Provider? If static, what is it?

[ pid your ISP assign you a subnet mask? If so, what is it?

O 1 you do not have a PPP or SLIP connection to the Internet, did your ISP assign you a
Default Gateway or Router IP address? If so, what is it?

] What is the DNS Address of your ISP (or note the IP address for your own DNS server)?
[ Does your ISP require a login script? If so, what are the prompts?

(] whatis your username and password information for your PPP or SLIP connection to the
Internet?

(] What is the telephone number you must dial in order to establish your PPP or SLIP
Internet connection (if you are using PPP or SLIP)?

] What type of modem or Terminal adapter, are you using to connect to the Internet?

] How are your computers networked together (e.g., via Ethernet, Token Ring, or
LocalTalk cabling)?

The last pages of the User Guide provide a place for you to write down and store all the
information needed to configure the Gateway. It is suggested that, once you have the
Gateway working, you make a copy of the preferences, and do a ‘Save Config As’ from the
“File” Menu printing the resulting file, to help out if any problems arise.



Internet Gateway Installation
Registering the Internet Gateway

By registering on-line at the Vicomsoft web site below, you will be able to access our
Technical Support services, and we can keep you up to date on our product developments.

http://www.vicomsoft.com/register.html

The Internet Gateway software must also be personalized before it can be installed. Note
that you do not need to personalize demonstration versions.

Put the Vicomsoft Internet Gateway disk into your Macintosh.

EE==— licomsoft Internet Gateway
2 items 1.1 MB in disk 273K available

<3

Register Gateway Install Gateway

1]
=l IRE

Double-click the “Register Gateway” icon, and the following window is displayed:

Personalize Your Gateway

@ "IIOOMSOFT Internet Gateway @

Please personalize your Vicomsoft Internet Gateway.

Name: [1 |

Organisation:

Serial Number :

Please register online at: hitp:/ /www.vicomsoft.com/register html

[I]nn’t Personalize] l[ Personalize ]]

Enter your name, organization, and the Gateway serial number provided in your
registration documentation. Click the “Personalize” button. The Internet Gateway software
can now be installed onto your computer.

Installing the Internet Gateway Software

The Internet Gateway Installer comes on two (2) disks. To install the Internet Gateway,
double-click on the “Install Gateway” icon. After an introductory screen, the following
window is displayed:

Install Gateway=—————————— B
Show Other Instalations OB
- -
Yicomsoft Internet Gateway PPC Internal
1 Gig External

v v

These are the recommended installations. To start, select one or more Read Me I

of these icons and drag to any available disk on the right side of the
windowe. Quit I

With this installer you have the option to “Show Other Installations”. The first Installer
window will install both the Internet Gateway and the WebCache Server. The second
window, displayed below, gives you the option to install the Internet Gateway OR the
WebCache Server.
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Install Gateway=——————— 8
B Show Recommended Installations g} 5y

&

PPC Internal

&

1 Gig External

Internet Gateway =
‘WebCache Server Module

v -

These are additional installations. To start, select one or more of Read Me I

these icons and drag to any available disk on the right side of the

window. Quit I

The installer will install a FAT binary applications. These will run on both 68K and
PowerPC Macintosh systems.

To run the Internet Gateway or the WebCache Server you must use Open Transport. With
any MacOS version below 8.0, we recommend using Open Transport version 1.1.2.

Both applications can only be installed onto a disk with a System folder. Drag the
Vicomsoft Internet Gateway icon to your Startup Disk on the right. This will create a folder
on the disk called “Vicomsoft”. Inside the Vicomsoft folder two other Folders will be
created, “Internet Gateway” and “WebCache Server”.

The following files are installed into there respective folders:
Internet Gateway folder

e The Internet Gateway application.

e The CyberUpdater application.

*  One or more ReadMe files providing supplementary information about the version you
have installed.

Installed with the Internet Gateway are:

* A VICOM Settings folder (in the Preferences folder of your System folder) where your
preferences and key Gateway files are stored.

e Apple Modem Tool— Used to make modem PPP and SLIP connections; installed in the
Extensions folder of the System folder.

e “-Gateway-"— Extension (placed in the Extensions folder) enabling TCP/IP client or
server applications to be used on the Gateway computer.

WebCache Server folder
e The Vicomsoft WebCache Server application.

e A LocalHtml Folder, contained in this folder is an Admin folder, an Images folder, and
all the Local HTML files.

11
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Entering the Activation Password

Double-click the Vicomsoft Internet Gateway icon to launch the Gateway software.

The first time the Gateway software is launched, it will prompt for an activation code. The
code is printed on your registration document.

Activation Password

This software requires an activation password to be enabled. This should have
been supplied on your reqgistration card if you purchased the product.

Please make sure to enter the activation password exactly as it
appears on your registration card.

To receive news of updates and for free technical support, please register
your Yicomsoft software product online at the following web page:
http:/ /www. vicomsoft com/register _html

Alternatively, you may report problems or request additional information by
contacting VYicom Technology using the methods described in the “ About”
box in this software or via the support area web pages at:

http:/ /www _vicomsoft .com/support/support.main_html

Password: || I

(Lcancer J [__ok_J

Please note that the password is case-sensitive, and ensure that you enter the password
exactly as it appears on your registration document.

Now you're ready to configure your Internet Gateway software.

12



TCP/IP Applications on the Gateway Computer

It is possible to run TCP/IP applications such as a web browser, email client, or even a mail
or web server on the Internet Gateway computer. However, since the Internet Gateway is
handling all IP packets, data sent or received by the application must pass through the
Internet Gateway.

Open Transport must always have an IP address, because of this the Internet Gateway
selects a port and attaches TCP/IP to that port. The Internet Gateway computer then
assumes the IP address of that port. The Internet Gateway will automatically configure
your TCP/IP control panel, this must not be changed.

The Internet Gateway will mark the attached port with a B jcon the Status window ports
list. You can change the attached port by highlighting the new port you wish to attached
TCP/IP to and then selecting “Change this Mac’s TCP/IP Address...” from the “Ports” Menu.
Note that you should quit any currently running TCP/IP applications before doing this.
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Configuring the Internet Gateway

To use the Internet Gateway to connect a LAN to the Internet, you must have an Network
Address Translation (NAT) port for your Internet connection, a Local Area Network port for

your client network, and a B icon the Status window, to allow other TCP/IP applications
to run on the Gateway computer.

When the Gateway is first launched Darko, the Auto Setup Guru, offers to configure it
automatically.

Auto Setup=——————————— B

% Introducing Darko, your Internet Gateway Setup guru.

= He will build a configuration based on your hardware.

I shall try to build:

® 4 connection to your Internet Service Provider

® LAN connections using your Ethernet, Localtalk or Token Ring interfaces.
At each step in the configuration process | will ask you for any information
I need.

You can cancel the configuration at any time and revert to the previous
settings.

“When | have finished, you may need to set this Mac up to use the software.
| will tell you what you need to do then.

You must also set your client machines up to use the software.
If you set them to use “Server configuration” the software
can do this for you automatically.

Cancel Auto-Setup Start Auto-Setup

Configure with the Auto-Setup or Manually?

Configure your Gateway manually or using the Auto Setup according to the following flow
chart. Both the Auto-Setup and Manual configuration are covered in this QuickStart Guide.

“ [ Cancel Auto-Setup ] |[ Start Auto-Setup ]I ||

ISDN Cards, Leased lines

The Auto-Set ks fa
and other connections. e Auto-Setup works for

Router, Cable Modem, ADSL,
ISDN Terminal Adapters, and

Follow these steps in the :
P regular Modem connections.

Quickstart Guide.

Read, The Mirror Port
on the Gateway Computer Follow Darko, the Gateway Setup
Guru, and he will explain the steps,

and ask questions about your:

—/

Read and Follow,
Configuring the Internet Proxy

S YSRhYa )

Port. + PPP Port
« Networking - Ma¢IP or Ethernet
Read and Follow « Domain Name Server Address
Configue the Local Area Network + DHCP for Client addressing
Port.

( Test your Internet connection. )

( Configure your Client computers. )

Configuration instructions for each type of port required are detailed in the following
pages. Keep in mind that you will need to create one NAT port and at least one Standard
Ethernet or MacIP port for your configuration.

14
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Configuring the Internet Gateway

Auto-Setup the Internet Gateway

When first opened, the Internet Gateway attempts to configure itself automatically based
on the configuration of your computer.

Auto Setup

% Introducing Darko, your Internet Gateway Setup guru.

= He will build a configuration based on your hardware.

I shall try to build:
® 4 connection to your Internet Service Provider

® LAN connections using your Ethernet, Localtalk or Token Ring interfaces.

At each step in the configuration process | will ask you for any information
I need.

‘You can cancel the configuration at any time and revert to the previous
settings.

“when | have finished, you may need to set this Mac up to use the software.
| will tell you what you need to do then.

You must also set your client machines up to use the software.
If you set them to use “Server configuration” the software
can do this for you automatically.

Cancel Auto-Setup Start Auto-Setup |I

Start Auto-Setup: will build the configuration prompting you at each screen. We recommend
that you read each screen before the Continue button is selected. Darko will stop and wait
when he needs your answers.

Cancel Auto-Setup: will allow you to leave the automatic setup process, without making
any changes. If this is the first time the Internet Gateway has been launched, the Status
window will appear with no ports listed. You will then need to manually configure the

Internet Gateway.

You can repeat the Auto-Setup process at any time when the Internet Gateway is

operational by selecting Auto Configure in the “Network” menu.

15



Configuring the Internet Gateway Installation and Quickstart

Step 1 - How will you connect?

First, Darko will ask you how you intend to connect to your Internet Service Provider. You
can connect using an Ethernet connection (ADSL, Cable Modem or Router), or you can connect
using a modem or an ISDN TA.

Auto Setup

% Firstly, 1’11 connect the Internet Gateway to the Internet.

= Please select the appropriate button depending upon your hardware.

Ctl"‘ v
For example -
m Select 'Using Ethernet’ to configure an ADSL or Cable Modem connection
D
Select "Using PPP' to configure a modem or ISDN Terminal Adapter
—
[ usingEthernet [ Using PPP ]|

Select the correct option for your setup, then go to the Step 2 that corresponds with your
selection.

16



Installation and Quickstart Configuring the Internet Gateway

Step 2 - Using PPP

If you select “Using PPP’ Darko will look for previous settings to make a PPP port for your
Internet connection. If you have used MacPPP, FreePPP, or Apple’s PPP, Darko will import
the information from the most recently used configuration. Darko will ask you for your
Password if uses your Apple PPP settings. If he can’t find a suitable preferences file, Darko
will ask you to fill in the following screen.

= futo Setup=—"———————H
I need some help.
= Please can you provide the following information for connection to your
= Internet Service Provider?
Connection Method : Login Method: (7} Unix Seript...
Open Modem Control Panel Q PAP Authentication...

IP Address: @) Dynamic

0.0.0.0

% “when you have finished, click a button

The Connection Method option allows you to select between using the Modem Control panel
or the Apple Modem Tool.

All the information requested should have been supplied to you by your Internet Service
Provider. Review the section in Chapter 1, “Information Required from Your Internet
Service Provider” for more details. When you have completed the above screen select
“Create PPP Port” to continue.

Step 2 - Using Ethernet

If you select “Using Ethernet’ Darko will help you make an Ethernet Proxy port for your
Internet connection, Darko will ask you to fill in the following screen.

=———— futoSetuyp=————H

I need some help.
E Please can you provide the following information for your Internet Port?

Card to use for Port : [ Built In v

Port IP Address : O Dynamic

@ Fixed.. (0000
Router IP Address : (0.0.0.0

(should be provided by your ISP)

% “When you have finished, click a button

Creste nternet Port_J|

All the information requested should have been supplied to you by your Internet Service
Provider. Review the section “Information Required from Your Internet Service Provider”
for more details. When you have completed the above screen select “Create Internet Port”
to continue.

17



Configuring the Internet Gateway Installation and Quickstart

Step 3 - Building a Local Area Network Port

Darko will ask you if you wish to build a MacIP port or an Ethernet port.

Auto Setup="—————————— 8

Clients can connect to Internet Gateway using either MaclIP or Ethernet.
% If you use LocalTalk, select MaclP; otherwise select Ethernet

:t"“" Y

Internet Port
123 123 4567

[ Use MaclP ] " Use Ethernet ]l

MacIP allows TCP/IP packets to be carried over an AppleTalk network to reach the
Internet Gateway. It can be used if you have clients who are attached to the Internet
Gateway using LocalTalk cabling.

Note: A MaclP port uses memory and slows down some Internet Gateway functions, do not set
one up if you don’t need it.

Step 4 - Building a Local Area Network Port

18

Darko will ask you enter the details for your Ethernet port.

Auto Setup=——————————— 1=}

I need some help.
E} Please can you provide the following information for your LAN Port?

Card to use for Port : [ Built In ﬂ

Port IP Address : () Dynamic

@) Fixed... 192.168.1.254

E “When you have finished, click a button
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Configuring the Internet Gateway

Step 5 - Entering a DNS Address

Darko will ask for a Domain Name Server address. You may type the DNS address into the
field provided. You should have received the DNS address information from your Internet

Service Provider.

Auto Setup = H

E I need you to provide a Domain Name Server (DNS) IP address.

= This should be supplied by your ISP.

The address you enter will be used to look up names of sites.

Your Internet configuration indicates that you may be able to
leave this blank.

E} “When you have finished, click a button

Step 6 - Enabling DHCP

The Internet Gateway includes a function called DHCP (Dynamic Host Configuration
Protocol) that can send TCP/IP configuration information automatically to the clients on an

Ethernet network. This saves having to configure them manually.

Auto Setup="————————— 8

The Internet Gateway is configured.
% You should now set up your Client computers.

If you click ‘Use DHCP”...

| shall enable the Internet Gateway ‘s Client Configuration facility (its DHCP Server), and then all
you have to do is to set each client to obtain its configuration from a DHCP or Bootp server.

If you click ‘Disable DHCP”...

You will have to configure the clients manually.

% “when you have finished, click a button

[ isabeorce [ Use DHCP I

It is strongly recommended that you use DHCP to simplify network address administration.
However, if you prefer to set up your client computers with manual IP addresses, select

Disable DHCP.

If you are using a Cable modem with a Dynamically assigned IP address and one

Ethernet connection, you will not be given the option to Enable DHCP.

19



Configuring the Internet Gateway Installation and Quickstart

Step 7 - Allow this Macintosh to use the Gateway

Now Darko will create the attached port because Open Transport must always have an IP
address. The Internet Gateway computer then assumes the IP address of that port.

The Internet Gateway will automatically setup your TCP/IP control panel and marks a port

with B in the Status window ports list. This port’s IP address will be the IP address of the
Internet Gateway computer.

Step 8 - Completed Auto-Setup

20

Darko will now show you the finished configuration.

Auto Setup="—————————— 8

Darko’s basic configuration should get you started.
E Use the Internet Gateway menus to make further changes to the Ports and

=" Preferences.
o
‘,‘ This Macintosh

Internet Port
123 123 4567

LAN Port
192.168.1.254
S

If you click OK, the Internet Gateway Status Window will appear.
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Manually Configuring the Internet Gateway

You only need to use this procedure if you need to configure an Internal ISDN Card, or a
Leased Line interface card.

In order to connect to the Internet using the Internet Gateway, you must create a Network
Address Translation (NAT) port. This is the port that hosts your single connection to the
Internet.

In order to create the NAT port, you will need to know the information specified in the
Introduction of this QuickStart Guide, such as your IP address, subnet mask, DNS (Name
Server) address, etc.

To begin, you will need to know your method of Internet connection. The Internet Gateway
supports connections from the following: modems, ISDN terminal adapters (TA) and cards,
cable modems, and router connections to the Internet (e.g., T1 line, ISDN Routers, ADSL,
etc).

21



Configuring the Internet Gateway Installation and Quickstart

ISDN Card or Leased Line Modem Connections to the Internet

When you cancel the Auto Setup Wizard take the following steps to manually set up your
Internet Gateway’s Internet NAT port:

1.

2.

22

Select “New Port” from the “Ports” Menu, to create a new port.

Create New Port=—————H

I General T Login Options Y Connect Options ]

Port Name I l

Connection

Method [_Modern ~)

Using “PPP*

IP Address
[ static Address

MNetwork Properties

Metwork Address Translation

[[] can Serve DHCP [C] Port Probe | hd|

[ cancer | [ ok |

If you have a static IP address assigned to you from your ISP, check the Static Address
box and enter the IP address. If you have a dynamic IP address, ignore this step.

If your ISP has assigned a subnet mask for your static IP address, enter the subnet mask
in the Subnet Mask box.

Configure the settings as follows:

*  Method: Select one of the following, Modem, CommsToolbox PPP, or
CommsToolbox SLIP

* Network Properties: Network Address Translation
When the option ‘Modem’ is selected the Internet Gateway will use the Modem settings

from your Modem Control panel to control your Modem. You will need to enter your ISPs
phone number in the Login Options tab.

If you are going to use an ISDN Card to connect to the Internet, you will need to Select a
CommsToolbox option. The select the correct ISDN Tool through the Apple Modem
Tool.
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5. Click the No Tool Selected button. The Apple Modem Tool will be displayed first.

6. Select the appropriate tool, if required, by clicking on Apple Mode..., and selecting the
correct Tool for your hardware and configure as follows:

Connection Settipas -“
4-Sight iSDN Tool
v Apple Modem Tool

Leo ISDN Tool
- Planet ISDN Tool .
rWhen dialing Settings

. Serial Tool
Dial Phone Number || Tr—emdRate: [ 2400 ¥ ] (cabling.. ]

Diating Method: Parity:

E Redial times every |10 seconds Data Bits:

‘When answering Stop Bits: EI
’7Answer phone after rings ‘ Handshake : 156

rModem option:

Modemn : Hayes-Compatible Modem v
rror Correction

o

Modem Port

@] [

Apple Modem Tool:

Enter the telephone number that you dial for Internet connections.

Select your modem in the modem options, or use the Hayes-Compatible setting.
You can create your own modem setting by selecting “Custom” and entering your
modem’s initialization string, provided by your modem or ISDN manufacturer.
Set your Baud Rate to the appropriate setting. It can be set to 115.2 for an ISDN
TA, depending on whether you are using MultiLink.

Parity should be None, Data Bits should be 8, and Stop Bits should be 1.

Set Handshaking to DTR & CTS.

Select the appropriate port for your modem (usually the modem port).

ISDN Card Tools:

Serial Tool:

Select the correct ISDN Tool, enter the telephone number for your ISP then the
correct protocol settings:

Planet ISDN Tool, select PlanetPPP.

4-Sight ISDN Tool, select HDLC Packet.

SCii ISDN Tool, select HDLC Packet.

LeoISDN Tool, select both HDLC Transparent and Block Mode 2K.

Set your Baud Rate to 57600.

Parity should be None, Data Bits should be 8, and Stop Bits should be 1.
Set Handshaking to DTR & CTS.

Select the appropriate port for your modem (usually the modem port).

Click OK out of the Connection Settings/Tool Setup window.

7. Click on the Login Options Tab.

8. If your

ISP uses PAP/CHAP Authentication, make sure Login Using is set to PPP

PAP/CHAP and enter your username and password in the appropriate boxes.

If you are using the Modem Control panel, you will need to enter your ISPs phone number
in the Login Options tab.

23
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Create New Port

General I Login Options T Connect Options ]

Login Using [_PPP PAP/CHAP v

User Name : Password :

Overall Timeout (Hrs :Mins :Sec

D Sen

[[] sen

[] Sen

[[] sen:

i [ sen

i [ Sen

D Sen

D Sen

d CR

d CR

d CR

d CR

d CR

d CR

d CR

d CR

d CR

[ cancel | [ ok

to your ISP’s specifications.

If your ISP requires a login script, then select Login Script and set up the script according

10. The Connect Options Tab allows you to adjust the Connection Type or if the Gateway
Auto connects, Framing, etc. The Defaults in this window should allow you to connect

with out any changes being made at all.
12. Click OK out of the New Port Window.

13. Select ‘Preferences’ from the “Edit” Menu.

14. Select the Network Tab. Enter your ISP’s Domain Name Server (DNS) address in the

DNS Addresses box.

Preferences

General | Network T Security T Logging TPPPServerT Caching ]

Addresses

Default Gateway Address

DNS Addresses

WINS Address

NAT User Timeout @ Hrs :Mins

Default Domain Name :

DNS Configuration

Enable DNS Caching
[X] Enable DNS Serving
[] ons Server Offline

[] Enable DHCP Serving
[z Use RIP Protocol
[ Enable Multihoming

[ cancel | [ oK

J

15. Click OK out of the ‘Preferences’” window.

16. You now have a PPP NAT port for your Internet connection.



Installation and Quickstart

Configuring the Internet Gateway

Cable Modem or Router Connection to the Internet

When you cancel the Auto Setup Wizard, take the following steps to manually set up your

Internet Gateway’s NAT port:

1.
2. Configure these settings as follows:
Method: Ethernet

Using: (Select Built in or Card Slot)

Select “New Port” from the “Ports” Menu, to create a new port.

Create New Port

f General T Login Options T Connect Options ]

Port Name I

Connection

Method [_Ethernet

Using [_Built In

~)
~)

IP Address

E Static Address: |192.168.1.254

Network Properties

D Network Address Translation
E Can Serve DHCP

Subnet Mask |255.255.255.0

[ Port Probe | v

[cancer | [ ok |

IP address, deselect the Static Address Box.

3. IP Address, if you have been assigned a static IP address and Subnet Mask, enter them
here. If you have not been assigned a Static

4. Network Properties, Select Network Address Translation.

5. Click OK out of the Create New Port Window.

6. Select ‘Preferences’ from the “Edit” Menu and select the Network Tab.

7. If you are using a router, enter the Router

's IP Address here. If you are using a cable

modem with a static IP address and you have been given a default router or gateway
address, enter that IP address in the Default Gateway box. If you have a dynamic IP
address assigned to you from your ISP, disregard the Default Gateway field. Please
read the note about DHCP and Cable modems in the section on Configuring Client

Computers in this QuickStart Guide.

= Preferentes=—————————— E
General I Network T Security T Logging TPPP Ser'verT Caching ]
Addresses DNS Configuration
Default Gateway Address E Enable DNS Caching
DNS Addresses E Enable DNS Serving
] ONS Server Offline
[[] Enable DHCP Serving
E Use RIP Protocol
WINS Address'] . . . [ Enable Multihoming
Default Domain Narne :
NAT User Timeout @ Hrs :Mins
[cancer | [ ok |

25
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8. If you have a static IP Address from your ISP, enter the ISP's DNS address in the Name
Server Address box. If your IP address is assigned to you dynamically from your Cable
Provider, only enable name resolving in this preference setting.

9. Click OK out of the ‘Preferences’ window.

10. You now have an Ethernet NAT port for your Internet connection.
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Configuring the Local Area Network Port

In order for the client computers on your local area network to connect to the Internet via the
Internet Gateway, you must create a logical network port for IP traffic to be routed through.
This is called the LAN port (or Local Area Network port).You may configure one or more
LAN ports depending on how many networks you wish to route through the Internet
Gateway to the Internet.

For example, if you have a cable modem connection to the Internet with both Ethernet and
LocalTalk clients, you would create an NAT port for your Internet connection (the cable
modem), and you would create both an Ethernet LAN port for your Ethernet clients, as well
as a MacIP port to accommodate your LocalTalk clients.

To create your LAN port(s), you will need to select the type of cabling that connects your
local area network. The Internet Gateway supports local area networks of the following
cable types: Ethernet, LocalTalk, and Token Ring.

The Internet Gateway also supports remote dial-in clients. This means that you can
configure a Dial-In PPP port for remote users to dial into to get Internet access via the
Internet Gateway. Descriptions of how to configure this type of port can be found in, Setting
Up Remote Access Services, in the Internet Gateway User Guide.

On an Ethernet LAN, you must decide whether to use dynamic or static IP addresses for your
clients. We strongly recommend using the Gateway DHCP server to provide dynamic
addressing, except in the following situations:

If you are using a cable modem or router access to the Internet and your ISP serves dynamic
addresses, then you must not connect dynamic address clients to the same network. In this
case you should either configure your clients with static IP addresses, or use a second
Ethernet interface for your LAN to provide a physically separate network where you can
use the DHCP Server.

Ethernet, LocalTalk/MacIP and Token Ring LAN Port(s)

When you cancel the Auto Setup Wizard take the following steps to manually set up your
LAN Port(s):

1. Select “New Port” from the “Ports” Menu, to create a new port.
2. Configure the rest of the settings as follows:
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e Method: Ethernet
e Using: (Select Built in or Card Slot)

Only select MacIP if you are using LocalTalk cabling to network your computers
together. Ensure that your AppleTalk control panel is set to the appropriate port.

Create New Port

B

I General T Login Options T Connect Options ]

Port Name I

Connection

Method [_Ethernet

]
~)

Using [_Built In

IP Address

E Static Address: |192.168.1.254

Network Properties

D Network Address Translation
Can Serve DHCP

Subnet Mask |255.255.255.0

[ Port Probe | v |

[ cancel | [ ok

Address will be passed on to your clients using DHCP.

7. Click OK out of the Create New Port window.

8. If you have decided to use dynamic addressing for Ethernet clients, then select
‘Preferences’, from the “Edit” Menu and select the Network Tab. Check the use DHCP
Protocol check box.

= Preferentes =———————— E
General | Network T Security T Logging TPPP ServerT Caching ]
Addresses DNS Configuration
Default Gateway Address E Enable DNS Caching
DNS Addresses E Enable DNS Serving
[] ons Server Offline
[] Enable DHCP Serving
E Use RIP Protocol
WINS Address'| . . . [ Enable Multihorning
Default Domain Name :
NAT User Timeout Hrs :Mins
[cancer | [ ok |
9. Enter the ISP's DNS address in the Name Server Address box. This DNS Server

10. You now have a LAN port for your client computers to connect to the Internet via your

Internet Gateway computer.



Testing the Internet Gateway

Modem, ISDN Card and ISDN TA users should start from the top. Cable modem users
should proceed to step 7. Hardware router users should go to step 9.

1. Highlight the PPP NAT port and select Connect in the Ports pull-down menu. You should
hear the modem dial and after a while you should see "Connected" alongside the port
in the Gateway's main status window. If so, proceed to step 9.

2. Highlight the NAT Port and select Reset Port in the Ports pull-down menu. The
modem/ISDN card or TA has failed to connect to the Internet correctly, therefore we
need to find out why. To do this, highlight the NAT Port and select Start Tracing Port
in the “Ports” Menu. Then select Connect in the “Ports” Menu, the trace window will
show the connection process.

3. If you see "Dialling out" and no more messages, the modem or ISDN device does not
appear to have dialled or the ISP has not answered the call. Check the modem or
ISDN TA is plugged in. Check the phone number you have entered. If you are using an
ISDN card or ISDN TA which does not use the Apple Modem Tool, check that the
ISDN tool is configured correctly.

4. If you are using PAP to log into your ISP, and you see "username or password rejected”
appear in the trace window, please re-enter your user name and password into the
Gateway. Check with your ISP that the username and password you are using is correct.

5. If you are using a login script and you see "Waiting for xxxxxx", it means that the login
script is set-up to wait for some text which is never received. Check the login script and
confirm with your ISP that it is correct.

6. If you see "Config_Req" constantly, it means that the Gateway and the ISP cannot get a
good enough PPP connection. Read Chapter 12, Troubleshooting, in the Gateway User
Guide.

7. With a cable modem and a static IP address turn the Gateway on to connect, then move to
step 9.

8. With a cable modem and a dynamic address, when you turn the Gateway on, your port
should turn from Dynamic to an IP address. If not check your port setup and try again. If
you are still do not assigned an IP address, read Chapter 12, Troubleshooting, in the
Gateway User Guide.

9. Once you are connected, select "Ping Host" from the “File” Menu. The default address of
195.224.200.2 is the IP address of an Internet server based at Vicomsoft. Press the start
button. The Gateway will send 5 "pings" to the remote host. If all is OK, the remote
host will send back 5 pings in return which the Gateway will receive. If you get the
message "Received after x seconds", proceed to step 12.

10. If Ping Host fails, it means the Gateway can not see the Vicomsoft Internet server. Try to
enter the IP address of your ISP's Domain Name Server into the Ping Host box and press
the start button again. If that works, a problem on the Internet maybe preventing you
from reaching Vicomsoft's Internet server, proceed to step 12.

11. Cable modem and router users should try to ping the IP address of the default Gateway
they have been told to use and have entered into the Default Gateway option within
the Gateway's preferences. If you are a cable modem user with a dynamic IP address, go
to the Default Gateway option and you should see an IP address in that box. Can you
ping that IP Address? If the default Gateway IP address cannot be pinged, check with
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your ISP what address you should enter into that box. Read Chapter 12,
Troubleshooting, in the Gateway User Guide.

12. Launch a web browser on the Gateway machine and enter a web server address (e.g.
www.vicomsoft.com). If you receive a web page, proceed to step 14. If not, try entering
and IP address in place of a web address, (i.e. 195.224.200.2) do you get Vicomsoft's web
page. If so check your Name Server Address entry, it may be wrong.

13. Open Transport is not communicating to the Gateway correctly. Check that you see a &
icon in the Gateway's main status window, if not read Chapter 12, Troubleshooting, in
the Gateway User Guide.

14. You can access the Internet from the Gateway machine. You now have to set-up the
client machines.



Configuring the Client Computers

Client computers must be set up so that they can use the Gateway when they need to connect
to the Internet. This chapter describes how to do this for a number of common client systems.

For local clients, these instructions assume that DHCP (Dynamic Host Configuration
Protocol) is enabled in the Gateway. DHCP is described in detail in Chapter 6 of the User
Guide. You may have enabled it during the Auto Setup process, or you can do so at any later
stage by selecting “Preferences” from the “Edit” menu, then the Networking Tab. All they
need is a TCP/IP stack. For MacOS-compatible computers, this can be either MacTCP or
Open Transport (i.e., the TCP/IP control panel).

You can have a combination of MacTCP and Open Transport clients. We do recommend using
Open Transport (version 1.1.2 or later) when possible. The Internet Gateway also supports
UNIX and Windows clients on your local area network. For more details please see the
Vicomsoft Internet Gateway User Guide.

You should only choose to disable DHCP if your Gateway computer is connected to a
network that already has an assigned TCP/IP address range. In this case your Clients
should already have been configured, but you will need to change their default router
addresses to that of the Gateway’s LAN Port in their networking setup.

Under certain circumstances you may not be able to enable the Gateway DHCP Server,
because cable modem providers who assign dynamic IP addresses use a DHCP server to do
so. If you are using a cable modem and have a dynamic IP address from your Cable Provider,
then it may be necessary to manually configure your client computers.

If you are connecting the Gateway to a Network that already has an assigned TCP/IP
address range, then the client computers should already be configured. You will only need to
change the default router addresses to that of the Gateway LAN port.

For your convenience, manual client configuration guidelines for some common desktop
computers are provided in Appendix A.

Manual Client Configuration

If your LAN computer needs to have a fixed or static IP address, then you’ll want to
configure it manually.

There are many reasons why a computer might need a fixed IP address: for other computers
on the local area network to access it via its IP address (e.g., via AppleShare IP), for
administrators to utilize the logging function and/or the Host Access Rights from within
the Internet Gateway, or if you're running an Internet server such as a web or email server on
your local area network.

In all these instances, the LAN computer must have the same fixed IP address each time it
utilizes IP services. For these reasons, you may wish to configure your client computer(s)

manually.

For manual client configuration, see the Vicomsoft Internet Gateway User Guide.
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Open Transport DHCP Client Configuration

1. Launch the TCP/IP control panel.
2. For Ethernet cabling, select Connect via: Ethernet and Configure: Using DHCP Server

from the pop-up menus.

TCP/IP

Connect via: Ethernet hd I
- Setup
Configure: Using DHCP Server v I

IP Address: < will be supplied by server >
Subnet mask: < will be supplied by server >

Router address: < will be supplied by server >

Search domains :

Narne server addr.: < will be supplied by server >

3. For LocalTalk cabling, select Connect via: AppleTalk (MaclIP) and Configure: Using

MaclIP Server from the pop-up menus.
fi—————— TP —————————

Connect via: AppleTalk (MacIF) ~]

Configure: l Using MacIP Server v I

- Setup

MacIP server zone: < current AppleTalk zone >
Select Zone...

IP Address: < will be supplied by server >

Search domains :

Name server addr.: < will be supplied by server >

4. Close the TCP/IP control panel.
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MacTCP Dynamic Client Configuration

On a busy network MacTCP may not pick up the IP address information sent to it by the
Gateway; it will therefore fail. The way to overcome this is to either set-up that computer
manually or to upgrade the computer to Open Transport.

1.

2.

3.

=

Launch the MacTCP control panel

EtherTalk

| IP Address: {0

206

In the first window, select LocalTalk, Ethernet, or the appropriate cabling scheme for

your network.
Click More to get to the second window.

~0btain Address: -y e ~|P Address:-
) Manually Class| |I] Address: 0.0.0.0
@ Server Subnet Mask: 255.0.0.0
O Dynamically MO
Net | Subnet | Node
Bits: 8 0 24

Oiack
[ERES
Oiack

---Domain Name Server Information:-
Domain IP Address I]efault

196.57.202.180 |© 5

~Routing Information:-
Gateway Address:

[ ok ] (cancer ]

Obtain Address from Server.
In the Domain Name Server Information field, enter a dot “.” in the Domain box, and

enter your ISP’s DNS address in the IP Address box.
Click OK, Close the control panel and Restart the computer.
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Setting up Windows 95/98 Clients

1. Open the Network control panel.
2. Highlight TCP/IP and click the “Properties” button.

TCP/IP Properties

Pt LT W1

3. Select the IP Address Tab and click “Obtain an IP address Automatically”.
4. Close the Network control panel.
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Setting up Windows NT Clients

1. Open the Network control panel.
2. Highlight TCP/IP and click the “Properties” button.

Microsoft TCP/IP Properties | 2| %]

IP Address | DNS | WINS Address | DHCP Relay | Fiouting|

An P address can be automatically assigned to this network card
by a DHCP server. If your network does not have a DHCP server,
ask your network administrator for an address, and then type it in
the space below.

Adapter:
| [11DEC PCI Ethermet DECchip 21040 |

& Obtain an IP address from a DHCP server

~ (" Specify an IP address

1P Address: I
Subnet Mask: I
Default Gateway: I

Advanced...
0K I Cancel | Apply |

3. Select the IP Address Tab and click “Obtain an IP address Automatically”.
4. Close the Network control panel.

Setting up Windows 3.x Clients

TCP/IP setup procedures vary according to the software installed. The following is a
typical example based on Netmanage NEWT:

1. Start up the “Custom” application that is installed with NEWT.

2. Select “Configuration” in the Setup Menu and check the box for “Use Dynamic
Configuration”.

3. Check the box for “DHCP”.

4. Close the Custom application.

Conclusion

You should find, after reading this Guide, that you can access the Internet from both the
Internet Gateway computer and your client computers. If you have any problems, it is
suggested that you read the Vicomsoft Internet Gateway User Guide and Chapter 12,
Troubleshooting.

If you wish to run any TCP/IP Server applications on the Gateway computer, you should
read Chapter 3, The Open Transport IP Address, in the User Guide.
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